
 

Microsoft Dynamics® GP
Fixed Assets Inflation Adjustment



Copyright Copyright © 2010 Microsoft. All rights reserved.

Limitation of liability This document is provided “as-is”. Information and views expressed in this document, including 
URL and other Internet Web site references, may change without notice. You bear the risk of using 
it.

Some examples depicted herein are provided for illustration only and are fictitious. No real 
association or connection is intended or should be inferred.

Intellectual property This document does not provide you with any legal rights to any intellectual property in any 
Microsoft product.

You may copy and use this document for your internal, reference purposes.

Trademarks Microsoft and Microsoft Dynamics are trademarks of the Microsoft group of companies. FairCom 
and c-tree Plus are trademarks of FairCom Corporation and are registered in the United States 
and other countries.

All other trademarks are property of their respective owners.

Warranty disclaimer Microsoft Corporation disclaims any warranty regarding the sample code contained in this 
documentation, including the warranties of merchantability and fitness for a particular purpose.

License agreement Use of this product is covered by a license agreement provided with the software product. If you 
have any questions, please call the Microsoft Dynamics GP Customer Assistance Department at 
800-456-0025 (in the U.S. or Canada) or +1-701-281-6500.

Publication date May 2010



F I X E D A S S E T S I N F L A T I O N A D J U S T M E N T i

Contents
Introduction ............................................................................................................................................... 1

What’s in this manual...................................................................................................................................1

Symbols and conventions ............................................................................................................................2

Resources available from the Help menu..................................................................................................2

Send us your documentation comments ...................................................................................................4

Chapter 1: Setup and cards......................................................................................................... 5
Setting up company information................................................................................................................5

Inflation adjustment account groups .........................................................................................................6

Assigning inflation adjustment accounts to an account group..............................................................6

Viewing the adjustment details for an asset .............................................................................................7

Assigning inflation adjustment accounts to an asset...............................................................................8

Chapter 2: Routines............................................................................................................................ 9
Adjusting inflation for an asset group .......................................................................................................9

Entering the adjustment percentages for a period.................................................................................10

Chapter 3: Inquiries and reports...........................................................................................11
Viewing the value of fixed assets after inflation adjustment................................................................ 11

Printing the inflation adjustment values .................................................................................................12

Printing the fixed assets adjusted costs report .......................................................................................12

Printing the depreciation values...............................................................................................................12

Printing the fixed assets net value report ................................................................................................13

Selecting the transaction account types ...................................................................................................13

Viewing the inflation adjustment information .......................................................................................14

Comparing the asset books after performing inflation adjustment ....................................................15

Glossary ...................................................................................................................................................... 17

Index .............................................................................................................................................................. 19



ii F I X E D A S S E T S I N F L A T I O N A D J U S T M E N T



F I X E D A S S E T S I N F L A T I O N A D J U S T M E N T 1

Introduction
Fixed Assets Inflation Adjustment is a tool that allows you to adjust the inflation for 
fixed assets, for each period of the fiscal year. You can use this tool only for assets 
that use the averaging convention method ‘None’. The adjustments are calculated 
using the annual, accrued monthly or monthly PAAG (Adjustment Percentage for 
the taxable year) methods. You can set up account groups and further assign a range 
of accounts to a group ID. You can also view and print reports for the inflation 
adjustment you have performed.

Check for current instructions
This information was current as of May 2010. The documentation may be updated 
as new information becomes available. Check the Microsoft Dynamics® GP online 
Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most current 
documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Fixed Assets Inflation Adjustment, and how it integrates with the 
Microsoft Dynamics GP system.

To make best use of Fixed Assets Inflation Adjustment, you should be familiar with 
systemwide features described in the System User’s Guide, the System Setup 
Guide, and the System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

This manual is divided into the following chapters:

• Chapter 1, “Setup and cards,” describes how to specify the accounts to be 
updated with the inflation adjustment and assign them to an account group.

• Chapter 2, “Routines,” describes the process of performing inflation adjustment 
for an asset group. You can also enter the adjustment percentages for a period as 
specified by the tax authorities.

• Chapter 3, “Inquiries and reports,” describes the process of viewing and 
printing reports for the inflation adjustments you have performed.

http://go.microsoft.com/fwlink/?LinkID=161199
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com


F I X E D A S S E T S I N F L A T I O N A D J U S T M E N T 5

Chapter 1: Setup and cards
Fixed Assets Inflation Adjustment allows you to adjust the inflation for fixed assets 
for each period of the fiscal year defined elsewhere in Microsoft Dynamics GP. You 
can use Fixed Assets Inflation Adjustment only for assets that use the averaging 
convention method ‘None’. The adjustments are calculated using the annual, 
accrued monthly or monthly PAAG (Adjustment Percentage for the taxable year) 
methods. You can set up account groups and further assign a range of accounts to a 
group ID.

The inflation adjustment process for fixed assets automatically adjusts the historical 
cost value of the asset with the adjusted depreciation. It also calculates the inflation 
adjustment on the depreciation of an asset for a specific period. You can also view 
the inflation adjustment on the depreciation of the asset and the inflation 
adjustment on the cost of the asset.

This information is divided into the following sections:

• Setting up company information
• Inflation adjustment account groups
• Assigning inflation adjustment accounts to an account group
• Viewing the adjustment details for an asset
• Assigning inflation adjustment accounts to an asset

Setting up company information

Use the FAIA Company Setup window to set up the fixed assets inflation 
adjustment information for your company.

To set up company information:
1. Open the FAIA Company Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> Company 
>> Additional >> Inflation Adjustments)

The Company Name field displays the name of the company you are logged 
into.

2. Mark the Adjust Fully Depreciated Assets checkbox to perform the inflation 
adjustment for fully depreciated assets.

3. Enter the asset serial number. This value increments by one each time an asset is 
adjusted for inflation.

4. Choose OK to save the changes and close the window.
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Inflation adjustment account groups

You can set up and use inflation adjustment account groups to speed up the process 
of entering account records when you add assets to your system. For instance, you 
can define an inflation adjustment account group for each class of assets that you set 
up using the Class Setup window, and then apply the default account group to 
assets you add to the class. When you add or change an individual asset, you will 
use the Account Group ID field in the Asset General Information window to add or 
change account group information for the asset. You also can use the Account 
Group ID field in the Asset Account window when changing an individual asset.

You can select up to seven accounts for each account group, as follows:

Adjustment Inf. Cost It is the account that is updated with the cost of the asset 
after performing inflation adjustment.

Contrap. Adj. Cost It is the account that is updated with the adjusted cost of the 
asset before performing inflation adjustment.

Adjustment Inflation Depreciation It is the account that is updated with the 
depreciation amount on the cost of the asset after performing inflation adjustment.

Contrap. Adj. Depreciation It is the account that is updated with the 
depreciation amount on the cost of the asset before performing inflation adjustment.

Depreciation Adjustment Inflation Cost It is the account that is updated 
with the depreciation on the adjusted cost of the asset after performing inflation 
adjustment.

Contra Depr. Adj. Cost It is the account that is updated with the depreciation 
on the adjusted cost of the asset before performing inflation adjustment.

Gain/Period by Inflation It is the account that is updated with the gain or loss 
incurred on the cost of the asset after performing inflation adjustment.

Assigning inflation adjustment accounts to an 
account group

Use the FAIA Account Group Setup window to define the inflation adjustment 
accounts for fixed asset account groups. You can specify up to seven accounts for 
each fixed asset account group ID. For more information about using account 
groups in your company refer to Inflation adjustment account groups on page 6.
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To assign inflation adjustment accounts to an account 
group:
1. Open the FAIA Account Group Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> Account 
Group >> Select an Account Group ID >> Additional >> Inflation Adjustments)

2. The Account Group ID and the Description fields display your selection in the 
Account Group Setup window.

3. Enter or select the account numbers for each of the accounts in the account 
group. For a description of each account, refer to Inflation adjustment account 
groups on page 6.

4. Choose Save to save the accounts, Clear to clear the values and Delete to delete 
the accounts you have set up.

Viewing the adjustment details for an asset

Use the FAIA Asset Book window to view the inflation adjustment details for an 
asset.

To view the adjustment details for an asset:
1. Open the FAIA Asset Book window.

(Cards >> Fixed Assets >> Book >> Additional >> Inflation Adjustments)

2. The Asset ID and Book ID fields default from the Asset Book window.

3. The Adjusted to Date field displays the date up to which the adjustments have 
been calculated. Refer to Entering the adjustment percentages for a period on 
page 10 for more information.
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4. The Cost Inf. Adjustment field displays the inflation adjustment amount 
calculated on the cost of the asset.

5. The Deprec Inf. Adjustment field displays the inflation adjustment amount that 
is calculated on the depreciation of the asset.

6. The Adj. Accumulated Deprec. field displays the inflation adjustment amount 
for the accumulated adjusted depreciation.

7. The Adjusted Net Value displays the net value of the asset after performing the 
inflation adjustment.

Adjusted Net Value = Asset cost + Cost Inf. Adjustment amount - depreciation 
value of the asset - depreciation inflation adjustment amount - adjusted 
accumulated depreciation.

8. Choose OK to close the FAIA Asset Book window.

Assigning inflation adjustment accounts to an asset

Use the FAIA Asset Account window to define the inflation adjustment accounts for 
an asset ID. You can specify up to seven accounts for each asset ID. These accounts 
are the accounts you have set up for an account group in the FAIA Account Group 
Setup window. Refer to Assigning inflation adjustment accounts to an account group on 
page 6 for more information.

To assign inflation adjustment accounts to an asset:
1. Open the FAIA Asset Account window.

(Cards >> Fixed Assets >> Account >> Additional >> Inflation Adjustments)

2. The Asset ID and the Status fields default from the Asset Account window.

3. Enter or select the account numbers for each of the accounts in the account 
group. For a description of each account, refer to Inflation adjustment account 
groups on page 6.

4. Choose Save to save the accounts, Clear to clear the values and Delete to delete 
the accounts you have set up.
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Chapter 2: Routines
Use this information to adjust the value of fixed assets for inflation for a specified 
period, using the inflation adjustment percentages.

This information is divided into the following sections:

• Adjusting inflation for an asset group
• Entering the adjustment percentages for a period

Adjusting inflation for an asset group

Use the Calculate Inflation Adjustment window to calculate the inflation 
adjustment for a fixed asset group for a specified period.

To adjust the inflation for fixed assets that are completely depreciated, you must 
have marked the Adjust Fully Depreciated Assets checkbox in the FAIA Company 
Setup window. Refer to Setting up company information on page 5 for more 
information.

You can post the adjustment entries to General Ledger in a batch on the transaction 
date specified in the Fixed Assets General Ledger Posting window (Microsoft 
Dynamics GP menu >> Tools >> Routines >> Fixed Assets >> GL Posting). Refer to 
the Fixed Assets Management documentation for more information.

To adjust inflation for an asset group:
1. Open the Calculate Inflation Adjustment window.

(Microsoft Dynamics GP menu >>Tools >> Routines >> Fixed Assets >> Pay 
Inflation Adjustments)

2. Enter or select an Asset Group ID for which to calculate the inflation 
adjustment.

3. Enter or select a Book.

4. Select the year for which to calculate the inflation adjustment. Choose the 
expansion button to open the Percentage of Adjustment window where you can 
enter the adjustment percentage for the year. Refer to Entering the adjustment 
percentages for a period on page 10 for more information.

5. The Period of Adjustment, Adjust to Date, and the Percentage of Adjustment 
fields default from the Percentage of Adjustment window.
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6. Select Post to post the inflation adjustments to the Fixed Assets Inflation 
Adjustment module. A report is printed displaying the inflation adjustment 
that was performed.

7. Select Report to preview the inflation adjustment before posting.

8. The Date of Accounting field displays the posting date for General Ledger 
entries. You can modify this date if required.

9. Choose Apply to calculate the inflation adjustment for the Asset Group.

10. Choose Clear to clear the values in the window, or Cancel to cancel the process 
and close the window.

Entering the adjustment percentages for a period

Use the Percentage of Adjustment window to enter the inflation adjustment 
percentages for a specified period.

To enter the adjustment percentages for a period:
1. Open the Percentage of Adjustment window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Fixed Assets >> Pay 
Inflation Adjustments >> Year of Adjustment expansion button)

2. Select the period for which to enter the adjustment percentage.

3. Choose the Percentage expansion button to open the Percentage Maintenance 
window where you can enter the percentage for inflation adjustment.

4. Choose Save in the Percentage Maintenance window to save the adjustment 
percentage and return to the Percentage of Adjustment window.

5. Choose Select in the Percentage of Adjustment window to select the period and 
the adjustment percentage and return to the Calculate Inflation Adjustment 
window.
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Chapter 3: Inquiries and reports
You can use this information to view and print reports for the inflation adjustments 
you have performed.

Fixed Assets Inflation Adjustment reports are available in the report list. You can 
select a report in the report list and add it to My Reports for easy access. Refer to the 
Microsoft Dynamics GP documentation for more information.

This information is divided into the following sections:

• Viewing the value of fixed assets after inflation adjustment
• Printing the inflation adjustment values
• Printing the fixed assets adjusted costs report
• Printing the depreciation values
• Printing the fixed assets net value report
• Selecting the transaction account types
• Viewing the inflation adjustment information
• Comparing the asset books after performing inflation adjustment

Viewing the value of fixed assets after inflation 
adjustment

Use the FAIA Asset Book Inquiry window to view the value of fixed assets after 
inflation adjustment.

To view the value of fixed assets after inflation 
adjustment:
1. Open the FAIA Asset Book Inquiry window.

(Inquiry >> Fixed Assets >> Book >> Additional >> Inflation Adjustments)

The Asset ID and Book ID fields default from the Asset Book Inquiry window.

2. The Adjusted to Date field displays the date up to which the adjustments have 
been calculated.

3. The Cost Inf. Adjustment field displays the cost of the asset after inflation 
adjustment.

4. The Deprec Infl. Adjustment field displays the inflation adjustment amount that 
is calculated on the depreciation of the asset.

5. The Adj. Accumulated Deprec. field displays the adjustment amount for the 
accumulated adjusted depreciation.
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6. The Adjusted Net Value displays the net value of the asset after inflation 
adjustment.

7. Choose OK to close the window.

Printing the inflation adjustment values

You can print the FAIA Payment Adjustment report to view the inflation 
adjustment values calculated and posted for an asset, for the last inflation 
adjustment process that was run. You can print this report from Reports >> Fixed 
Assets >> FAIA Payment Adj.

Printing the fixed assets adjusted costs report

You can print the FAIA Adjusted Cost report to view the adjusted cost of the fixed 
assets for a specified asset range. The adjusted cost is the cost of the asset after it has 
been adjusted for inflation.

To print the fixed assets adjusted costs report:
1. Open the FAIA Adjusted Cost window.

(Reports >> Fixed Assets >> FAIA Adjusted Cost)

2. In the Assets field, select All to print the report for all the assets. You can also 
enter a range in the From and To fields respectively to print the report for the 
assets that fall in the specified range.

3. Choose Print to print the FAIA Adjusted Cost report.

4. Choose Cancel to cancel the process and close the window, or Clear to clear the 
values in the window.

Printing the depreciation values

Use the FAIA Adjusted Depreciation window to print the depreciation values for a 
specified range of fixed assets.

To print the depreciation values:
1. Open the FAIA Adjusted Depreciation window.

(Reports >> Fixed Assets >> FAIA Adjusted Depreciation)
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2. In the Assets field, select All to print the report for all the assets. You can also 
enter a range in the From and To fields respectively to print the report for the 
assets that fall in the specified range.

3. Choose Print to print the FAIA Adjusted Depreciation report.

4. Choose Cancel to cancel the process and close the window.

Printing the fixed assets net value report

Use the FAAI Adjusted Net Value window to print the net value report for a 
specified range of fixed assets. The net value of an asset is equal to the adjusted cost 
of the asset minus the adjusted depreciation.

To print the fixed assets net value report:
1. Open the FAAI Adjusted Net Value window.

(Reports >> Fixed Assets >> FAIA Adjusted Net)

2. In the Assets field, select All to print the report for all the assets. You can also 
enter a range in the From and To fields respectively to print the report for the 
assets that fall in the specified range.

3. Choose Print to print the FAAI Net Adjusted report.

4. Choose Cancel to cancel the process and close the window.

Selecting the transaction account types

Use the FAIA Financial Detail Inquiry window to select the transaction account 
types for which to view transactions in the Financial Detail Inquiry window. You 
can use these filters only if you have unmarked the All Types checkbox in the 
Financial Detail Inquiry window. Mark the All Types checkbox to include all asset 
records, regardless of their transaction account type.

To select the transaction account types:
1. Open the FAIA Financial Detail Inquiry window.

(Inquiry >> Fixed Assets >> Financial Detail >> Additional >> Inflation 
Adjustments)
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The Asset ID and Book ID fields display the values from the Financial Detail 
Inquiry window.

2. Select the Transaction Account Type Filters group for which to view 
transactions.

Cost Adj. Mark this transaction account type to view all the transactions for 
the inflation adjustment performed on the cost of the asset.

Cost Depr./Adj Mark this transaction account type to view all the 
transactions for the inflation adjustment performed on the depreciation of the 
asset.

Util./Per. Inflation Mark this transaction account type to view all the 
transactions for the inflation adjustment performed on an asset that is retired, or 
if you have reversed a retired asset.

Adj. Depreciation Mark this transaction account type to view all the 
transactions for the inflation adjustment performed on the adjusted 
depreciation accumulated.

3. Choose Redisplay to refresh the information displayed in the Financial Detail 
Inquiry window as per your selection.

4. Choose OK to close the window.

Viewing the inflation adjustment information

Use the Financial Detail Inquiry window to view the assets for which you have 
performed the inflation adjustment. In the Source Doc. Filters group, unmark the 
All Documents checkbox and select the source document to view the inflation 
adjustment. You can select the following source documents to view the inflation 
adjustment information.

FAIAD Select this source document to view the transactions for inflation 
adjustment on the cost of the asset.

FADIA Select this source document to view the transactions for inflation 
adjustment on the depreciation of the asset.

FAIDE Select this source document to view the transactions for inflation 
adjustment on the adjusted depreciation accumulated during the year.

FARETIA Select this source document to view the inflation adjustment 
transactions that are posted when an asset is retired, or if you have reversed a 
retired asset.

The scrolling window displays the details of all the inflation adjustment 
transactions. Refer to the Fixed Assets documentation for more information on this 
window.

You must choose the Redisplay button in the FAIA Financial Detail Inquiry window to 
refresh the information displayed in this window according to your selection.



F I X E D A S S E T S I N F L A T I O N A D J U S T M E N T 15

C H A P T E R  3    I N Q U I R I E S  A N D  R E P O R T S

Comparing the asset books after performing inflation 
adjustment

Use the FAIA Book Compare Inquiry window to compare the inflation adjustment 
values for up to three books for an asset.

To compare the asset books after performing inflation 
adjustment:
1. Open the FAIA Book Compare Inquiry window.

(Inquiry >> Fixed Assets >> Book Compare >> Additional >> Inflation 
Adjustments)

The Asset ID and Asset Class ID display values from the Book Compare Inquiry 
window. You can view the inflation adjustment for the books you have selected 
in the FAIA Book Compare Inquiry window.

2. The Adjusted to Date field displays the date up to which the adjustments have 
been calculated. Refer to Entering the adjustment percentages for a period on 
page 10 for more information.

3. The Cost Inf. Adjustment field displays the inflation adjustment amount 
calculated on the cost of the asset.

4. The Deprec Inf. Adjustment field displays the inflation adjustment amount that 
is calculated on the depreciation of the asset.

5. The Cost Adjustment Deprec. displays the inflation adjustment amount for the 
adjusted depreciation accumulated during the year.

6. The Adjusted Net Value displays the net value of the asset after performing the 
inflation adjustment.

7. Choose OK to close the window after viewing the information.
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Glossary
Adjustment inflation cost

Cost of the asset after performing the 
inflation adjustment.

Adjustment inflation depreciation
Depreciation on the cost of the asset after 
performing inflation adjustment.

Gain/Period by Inflation
The gain or loss incurred on the cost of the 
asset after performing inflation adjustment.

Historical cost
Acquisition cost of the asset plus all normal 
incidental costs necessary to bring the asset 
into existing use and location.

PAAG
Inflation adjustment index provided by the 
legal authorities.
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FAIA Adjusted Depreciation report 

12
FAIA Payment Adjustment report 12

required fields, described 3
resources, documentation 2

S
symbols, used in manual 2

T
transaction account types, selecting 13

U
upgrade information, accessing on the 

Web 3

W
what’s new, accessing 3
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